About the Author

**Isha Kapoor** is a SharePoint Geek, a Vivid blogger, Author, Trainer and a SharePoint Server MVP from Toronto Canada. She is a founder and primary Author of famous SharePoint website [www.LearningSharepoint.com](http://www.LearningSharepoint.com).

Isha has more than 7 years of experience in SharePoint and has implemented multiple SharePoint projects for various Fortune 500 Companies across North America. She currently works as a SharePoint Consultant through her Toronto based Company [Akrura Technologies](http://www.akrurat.com).

You can connect with Isha on [Facebook](http://www.facebook.com), [Twitter](http://www.twitter.com) and [LinkedIn](http://www.linkedin.com) or you can email her at admin@learningSharepoint.com.
Disclaimer: The contents of this document are provided “AS IS”. Information and views expressed in this document, including URL and other Internet website references, may change without notice. You bear the risk of using it.

SharePoint, MOSS, SharePoint 2010, SharePoint 2013 and Microsoft are trademarks of the Microsoft Corporation.
# Table of Contents

**Create Sites or Subsites** (Chapter 1) ................................................................. 2
- Create a SubSite
- Create a Project Site
- Team Site Vs Project Site
- Timeline and Project Summary WebPart
- Create a Community Site

**Create Lists and Libraries** (Chapter 2) .............................................................. 17
- Create a Custom List
- Create a Custom Document Library
- Create a Task List
- Create a Discussion Board

**Custom Pages** (Chapter 3) ..................................................................................... 32
- Create a WebPart Page
- Error Pages
- Add a Page Option
- Changing the default page layout
- Set a Welcome Page

**Users, Groups & Permissions** (Chapter 4 ) ............................................................ 42
- Create Groups
- Add Users
- Create new Permission level
- Edit Permission level for default Members group
- Set unique Permissions for a SharePoint List/Library

**Web Content Management** (Chapter 5 ) ............................................................... 60
- Drag and Drop multiple documents
- Move multiple documents from one library to another
- Digital Assert Content Types
- Asserts Library and new Video Content Type
- IFrames in SharePoint 2013
- How to add a YouTube Video in SharePoint 2013 site
Chapter 1

Create Sites or Subsites

Assuming that an initial Site Collection has already been setup, the very next task that an administrator would like to perform is to add a Subsite or a Web in its Site Collection.

In SharePoint 2013, you have option to add Subsite of type **Collaboration** - Team site, Project site, Community site and Blog site. **Enterprise** - Document Center, Record Center, Business Intelligence Center, Enterprise Search Center, Basic Search Center and Visio Process Repository. **Publishing** - Publishing site, Publishing with Workflow site and Enterprise Wiki Site, **Duet Enterprise** - SAP Workflow site and **Custom** - Any Custom Site Template. The type of sites available for Creating a Subsites depends upon the activation of corresponding feature in your Site or Site Collection.

In this Chapter we will look at the Detailed steps of Creating some these Subsites in a Site collection.
Create a SubSite

In SharePoint 2013, you can Create a Subsite using the “new subsite” Link available on Site Contents Page. Unlike SharePoint 2010, this Option to Create a Subsite is not available in Site Actions or Settings menu by default.

To create a new Subsite in SharePoint 2013, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of you site and select “Site Contents” page.

2. In the Site Contents Page, under Subsites heading click on “new subsite” Link.

3. When New SharePoint Site page appears, enter Title and Description, Web Site Address (URL), Template, Permissions and Navigation Inheritance.
Click Create when done. You will be redirected to the Site Contents Page and the Subsite will be listed towards the end (under Subsites) See below.
Tip

When you Create a subsite, it automatically gets added to your ‘Sites I’m following’ list. You can view the list of sites that you follow from your Mysites page.
Create a Project Site

SharePoint 2013 has added a new Template called “Project Site”, that comes with a set of webparts and pages to help Project Managers and Team members work on a project efficiently. With Project Sites, users can capture tasks and assign them to people in their organization, store and manage project-related documentation, track project team events on a common calendar, View Project Status on a Timeline and more.

Each project site has “Project Functionality” Site Feature activated by default. This feature adds a task list with a visual timeline, a calendar, and the Project Summary web part to Project sites. You can activate this feature for any Team Site to add these Project specific Capabilities.

To create a new Project Site in SharePoint 2013, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of your site and select “Site Contents” page.

2. In the Site Contents Page, under Subsites heading click on “new subsite” Link.

3. When New SharePoint Site page appears, enter Title and Description, Web Site Address (URL), Template, Permissions and Navigation Inheritance for your new Project site.
Click Create when done.

4. Your new Project Site should be visible under “SubSites” on Site Contents page. Click on the Project Site to Open it.
5. Click on the Project Site to Open it.

On your new Project site you’ll notice - Project Summary Webpart, Getting Start with your Site (or Tiles webpart), NewsFeed Webpart and a default Task list with a Timeline. These new webparts and lists, can help Teams in Tracking Projects, Managing Projects, Assigning tasks and Collaborating with Content related to Projects in a more productive way.
Team Site VS Project Site

Project Sites

* Project Sites has “Project Functionality” Site Feature activated by default.
* A Project Summary WebPart is added to the main page by default.
* Project Sites had “Task” list added to it by default.

Team Sites

* Team Sites has “Wiki Page Home Page” Site Feature activate by default.
* “Project Functionality” Feature is not active by default.
* Project Summary WebPart is not added to the site by default.
* Team Sites has “Team Task” list added to it by default.

TimeLine & Project Summary WebParts

TimeLine & Project Summary are new WebParts that gets added to each site created using Project Site Template.

TimeLine WebPart

Similar to Microsoft Project Server, Timeline webpart in SharePoint 2013 provides an overview of the tasks that are added to a task list on a SharePoint site. Every Task list by default displays a Timeline webpart, but you can also add it to one or more SharePoint pages on your site. With Timeline webpart, users have ability to Add, Remove, display, Indent, outdent, move, and delete tasks and subtasks. In addition to task management users can also change the font face, size, format, and color for the text used on the timeline. A Typical Task list Timeline is shown in Figure below.
The Timeline above displays three tasks and a subtask that is added to the corresponding Task list below. These tasks are first created in the Task list and then added to the Timeline. See more about Tasks list and Timeline in the Chapter.

Project Summary WebPart

Project Summary Webpart is essentially a Timeline Webpart that provides a high-level view of the events and tasks involved in a project. This WebPart is added by default to a SharePoint 2013 Project Site.

A typical Project Summary WebPart connected to Tasks List is shown in the figure below.
How to add a Project Summary WebPart

If a Project Summary WebPart is not added to your site, you can add it from a List of WebParts available under “Insert” tab in your sites Ribbon. To add a new Project Summary WebPart, follow these steps:

1. Edit the Page where you intend to add the WebPart.
2. Select the Insert Tab in the Ribbon and under Categories select Content Rollup.
3. In Parts section, select “Project Summary” and then select the add button.

Tip
If you do not see the Project Summary WebPart listed under the Insert tab in your site, make sure you have “Project Functionality” Site Feature Active under Manage site features in the site.

Other than Timeline, with Project Summary WebPart, you can also display a Summary of upcoming and late Tasks and Events that are added to one or more Tasks lists and Calendar lists in the site. See the Upcoming Tasks and Events in the Fig below.
**upcoming and late** views can be configured from Project Summary WebPart’s webpart Properties. See the Webpart properties in the Fig below.

**upcoming view** - Displays all the upcoming Tasks and Events from the connected Task & Calendar lists in the site. The Upcoming Panel lets you select the Task & Calendar list and the number of days for which Upcoming Items would be shown. See Fig. below
Things to Note
* A Calendar list shows up in Project Summary WebPart’s upcoming view only if it has any Upcoming Events added to it.
* Recurring events are shown under Upcoming View for each day of recurrence.

late view - Displays only “Tasks” that are over the due date. Calendar events are not added in this View. The edit link next to late is used to select multiple Task lists in the site. See Fig. below.
Create a Community Site

“Community site” is a new Template that has all new Social capabilities of SharePoint 2013. Community Sites is essentially an extension to Discussion boards with a lot more options in Community Tools (that is used for managing discussions boards and blog posts in the site).

To create a new Community Site in SharePoint 2013, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of you site and select “Site Contents” page.

2. In the Site Contents Page, under Subsites heading click on “new subsite” Link.

3. When New SharePoint Site page appears, enter Title and Description, Web Site Address (URL), Template, Permissions and Navigation Inheritance for your new Community site.
Community Tools

Community Tools is for managing discussions, Categories, Reputation Settings in Community site, like you were presented in Discussion boards and blog posts.

Community tools
- Manage discussions
- Create categories
- Assign badges to members
- Reputation settings
- Community settings

In Community Tools you can -
- Manage discussions –
- Create categories
- Assign badges to members
- Reputation settings
- Community settings
* **Reputation model** - Besides creating discussions you can create an employee or user reputation model based on his/her’s participation in community social activities. By this I mean you can assign badges (Achievement levels) to users and give them points for the activities (Member achievements point system) that user performs for example creating Posts, Replying to discussions etc. All these options are set by Admin of the site using “Reputation settings” A quick screen will give you an idea.

* **Like & Rely** - Users can Like and Reply on discussions.
Chapter 2

Create Lists and Libraries

In SharePoint 2013, Microsoft has introduced a new feature called “Apps”. As per MSDN, Apps for SharePoint are self-contained pieces of functionality that extend the capabilities of a SharePoint website. Lists, Libraries, Calendars, Discussion boards, Surveys are all called “Apps”. For example, a Custom List template is now called a “Custom List App” and a Document Library template is now a “Document Library App”.

In this Chapter we will look at the detailed steps of Creating Lists and Libraries using some of these new apps.
Create a Custom List

To Create a Custom List from a Custom List App, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of your site and select “Add an app”. Alternately, you can navigate to Site Contents page and select “add an app”.

2. In the Site Contents Page, under Noteworthy select Custom List app. You can also click on App Details link below Custom List app to view its description.

3. When you select Custom List, a popup window for List name appears. Enter an appropriate name for your Custom List.
4. Click Create. This creates your Custom List and adds it to List of Apps available on Site Contents page.

5. Click on Project List to open your newly Created Custom List.
Create a Custom Document Library

Creating a Document Library is similar to Creating a list. To Create a Custom Document Library from a Document Library App, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of your site and select “Add an app”. Alternately, you can navigate to Site Contents page and select “Add an app”.

2. In the Site Contents Page, under Noteworthy select Document Library app. You can also click on App Details link below Document Library app to view its description.

3. When you select Document Library, a popup window for Library name appears. Enter an appropriate name for your Document Library.
4. Click Create. This creates your Document Library and adds it to List of Apps available on Site Contents page.

5. Click on Document Repository to open your newly Created Library.
**Tip**

Although, adding apps is the preferred way to Create lists and libraries in SharePoint 2013, you can still use Create.aspx page for creating Lists and Libraries the old way by simply opening the URL `https://siteUrl/_layouts/15/create.aspx` in your browser and selecting the appropriate template.

---

Create a Task List

Creating a Task List is similar to creating a Custom list, but you need to select “Tasks app” instead of “Custom List app” for Creating a new Task List. To Create a Custom Task List from a Tasks app, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of your site and select “Add an app”. Alternately, you can navigate to Site Contents page and select “add an app”.

2. In the Site Contents Page, find and select Tasks app. You can also click on App Details link below Tasks app to view its description.

3. When you select Tasks app, a popup window for Task list name appears. Enter an appropriate name for your new Task List and Click Create.
4. This creates your new Tasks List and adds it to List of Apps available on Site Contents page.

5. Next Click on your Task list to open it. Notice the new features as highlighted in the screen below -
To represent tasks in a Typical Task list, a default Timeline WebPart gets added.

**Timeline WebPart**

Similar to Microsoft Project Server, Timeline web part in SharePoint 2013 provides an overview of the tasks that are added to a task list on a SharePoint site. Every Task list by default displays a Timeline webpart, but you can also add it to one or more SharePoint pages on your site. With Timeline webpart, users have ability to Add, Remove, display, Indent, outdent, move, and delete tasks and subtasks. In addition to task management users can also change the font face, size, format, and color for the text used on the timeline. A Typical Task list Timeline is shown in Figure below.
The Timeline above displays three tasks and a subtask that is added to the corresponding Task list below. These tasks are first created in the Task list and then added to the Timeline. See more about Task and Timeline in section at page no.

The Timeline webpart when selected displays a new tab “TIMELINE” in the Ribbon from where users can choose – Font & Color scheme for the tasks, Display Formats like Date and Time format, Task dates etc. for the tasks, Display Options (Bar or Callout) for tasks and can set the Width of the Timeline. See the various options available for task in Timeline in the figure below.

Add task to Timeline

Any Task can be added to Timeline after it’s been added to the Task list. When you create a new task and it’s available in the Task list, Click on “… (call up menu) to open task preview window. Here you can select “ADD TO TIMELINE” to add the task to the above timeline. You can remove it same way with “Remove from timeline”.
Create SubTask and Add to Timeline

Adding a new Task to a Task list is simple, just select the new Task link and add the entries in the form. Adding a new SUBTASK to an existing task is however a little different. To create a new subtask select “CREATE SUBTASK” action in a Task’s CallOut or Preview pane (as shown in figure above). The current task list view is then set to edit mode. When the list is in edit mode, you can simply create a subtask by adding a new row below the original task and intending it. Click on new row to save the changes. This is how it looks when you create a subtask.

Click on All Task view to go back to the Original view. Below is how it looks like in your Task Timeline.

Stop editing this list

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Due Date</th>
<th>Assigned To</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Task</td>
<td>August 10</td>
<td></td>
</tr>
<tr>
<td>First Subtask</td>
<td>4 days from now</td>
<td></td>
</tr>
</tbody>
</table>
Delete Task from Timeline

Deleting a Task from Timeline is simple, use “Remove from timeline” option in tasks “… (call up menu).

Delete Task from Task List

Finally, if you wish to delete a task from the Task list altogether, you can select “Delete Item” option from task’s ECB menu. To Open ECB menu click on the call up menu first and then in CallOut, again select the … menu.
Create a Discussion Board

Discussion Boards got a huge makeover in SharePoint 2013. Besides a new UI, there are few new Views (Flat, Management, and Threaded) introduced, along with an advanced functionality of Replying, Editing and setting Alerts on an individual Discussion. Before we look at these features in more detail, let’s look at how to create a new discussion board in SharePoint 2013.

Create a new Discussion

Click on a discussion board to open it. Next click on the new discussion button to create a new discussion.

Add discussion title and description for the new discussion board.

Click Save to Create it.
Once the new discussion is created you can see it listed in the main Discussion board.

Reply to a Discussion

For a new discussion, you can Reply, Edit and select Alert me, Mark as featured and delete using the ECB\call up menu.

To reply to a discussion simply click on the ‘Reply’ link or you can reply using the text field available at the bottom of the discussion.

Reply to a Discussion

Each discussion can be seen with many different Out-of-Box Views. The views available are –

- Flat
- Management
- Threaded
Flat View

Flat is the default View that you see in above screens.

Management View

Management is the view for Admins to see the Reply statistics for this discussion.

Threaded View

This displays the discussion in the form of old Discussion view (of SharePoint 2010).

Tip

You can add two kinds of discussions in SharePoint 2013.

- Using Discussion Board List.
- Using Discussions in Community Sites.
Chapter 3

Custom Pages

In SharePoint 2013, custom pages can be added using various out-of-box Page Layouts like WebPart page, Article page, Welcome Page, Error Page etc. Each Page Layout has its own purpose. A webpart Page layout for example is used for adding webparts to a custom page, and an error page layout is generally used create a Customized 404 Error page for the current site.

In this Chapter we will look at the detailed steps of Creating Custom Pages and setting a custom Page as Welcome Page for the current site.
Create a WebPart Page

WebPart Page is one of the popular layouts used for adding Custom WebParts on a SharePoint 2013 site page. To create a webpart page using WebPart Page Layout, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of your site and then select “Site Contents Page”.
2. Then select “Site Pages” or simply pages library on Site Contents Page.

3. Click on “Files tab” in the Ribbon and then select “New document -> Web Part Page”.

4. Use the WebPart Page Layout to create your Custom Page.
Error Pages

SharePoint 2013 now supports 404 PageNotFound error pages that are added in “Pages” library of a publishing sites by default. These error pages are created using the new Error Content Type.

PageNotFoundError.aspx Page

By default, all publishing sites contain a default 404 Error page “PageNotFoundError.aspx” which is added to the “Pages” library (See below).

This page can be modified or replaced to add custom text of your own.

Error Page Content Type

To allow users to Create a new 404 Error page, Publishing Sites now contain a new Content Type called “Error Page”. This Content type Inherits from “Page” Content type and has a typical layout of a Page Not found or 404 pages. To find this Content type Navigate to Site Settings -> Content Types -> Error Page.
Set Custom Error Page as Default

You can either edit the default `PageNotFoundError.aspx` in pages library or replace the default one with your own Custom Page.

Though there are various options to change the default 404 Page Not Found page in SharePoint 2013, but one of the easiest and quickest ways is to set `vti_filenotfoundpage` in “Site Options” using SharePoint Designer 2013.

Set ‘vti_filenotfoundpage’ in SharePoint Designer 2013

With the new Site Options in SharePoint Designer 2013, you can set the `vti_filenotfoundpage` property of your SharePoint 2013 site to a Custom Error Page that you might have created.

Simply open your Site in Designer and Under “Site Options” -> Parameters (tab) modify ‘vti_filenotfoundpage’ property to add a relative URL to your Custom error Page. See the Screen below -
“Add a Page” Option

The quickest way to add a Page in SharePoint 2013 site is by using the new “Add a Page” option in Site Settings menu.

For a typical Team site, when you select “Add a Page” option, a popup to create a new page using Article Page Layout gets displayed.

You can use this popup to add a custom page in your SharePoint 2013 site in two steps.
Changing the Default page Layout

To change the default page layout for “Add a Page” option or for your entire SharePoint 2013 Publishing site, you can use the “Page layouts and site templates” feature in Site Settings and set the desired layout in “New Page Default Settings”.

To set a default page layout in SharePoint 2013, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of your site and select “Site Settings”.

2. In the Site Settings page, under “Look and Feel” Select “Page layouts and site templates”. Make sure you have Publishing feature enabled to see this option.
Site Settings

Users and Permissions
- People and groups
- Site permissions
- Site collection administrators
- Site app permissions

Look and Feel
- Design Manager
- Master page
- Title, description, and logo

Web Designer Galleries
- Page layouts and site templates
- Welcome Page
- Device Channels
- Tree view
- Change the look
- Import Design Package
- Navigation
- Image Renditions

Site Actions
- Manage site features
- Reset to site definition

3. In Page layouts and site templates page, in “New Page Default Settings” section, select the page Layout that you need to set as default in “Select the default page layout:” list.
Set a Welcome Page

There are two main options to set a Custom Page as Welcome Page in your SharePoint 2013 Team site.

Using Make HomePage Button

For a typical SharePoint Team site, you can set a Custom Page as Welcome Page by opening the Page and selecting the Page tab -> Make HomePage button.

Using SharePoint Designer 2013

Another option to set a Custom Page as Home Page is by using SharePoint Designer 2013. If you have opened or created a Page in SharePoint Designer, you can simply right click on the page and select Set as Home Page.
Set Welcome Page for Publishing Sites

If you are using a Publishing site (or site with publishing feature enabled), you can use the old “Welcome Page” link on the Site settings page to set the URL of your custom page as Welcome Page for your SharePoint 2013 site.
Chapter 4

Users, Groups & Permissions

Adding users, groups and new permission levels in a SharePoint site is an essential administration task. When a SharePoint 2013 site is created, few Groups are created by default - Owners, Visitors, and Members; for more precise control of user access to sites, site collections, and site content, you can add Custom User Groups configure custom permission levels and set unique Permissions for a SharePoint 2013 site.

In this Chapter we look at the steps of Creating new Groups, adding new users and creating custom permission levels for a SharePoint 2013 site.
Create Groups

When a SharePoint 2013 Team site is created, few new groups get created by default. The Owners group, Members group and Visitors group among them are the main. These groups are ready to use with Full Control, Edit and Read permissions respectively assigned to them.

To create a new group however, administrators have to use the old “People and Group” option in SharePoint 2013 site’s site settings.

To create a new SharePoint 2013 Group, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of your site and select “Site Settings”.

2. In Site Settings Page, under “Users and Permissions” select “People and Group”.

Site Settings
In People and Groups, notice the default groups on the right.

3. Under the list of default groups, click more....
4. When you see the list of groups, in the “New” tab select “New Group”.

5. In the “Create Group” screen enter the group name, group owner and Group Permissions.
6. Click on Create to save your new group.
Add Users

Once the groups have been created, the next main task is to add users to the groups. Adding users is similar to adding Groups in SharePoint 2013. To add new users to a SharePoint 2013 Group, follow these steps:

1. Click on Site Settings Wheel in the upper right corner of you site and select “Site Settings”.

2. In Site Settings Page, under “Users and Permissions” select “People and Group”.

3. Next, select the group that you need to add users into. Click on the group name.

4. In the group select “New” and then “Add users & Add Users to this Group”
5. Next, in Share this Site Popup add the email address or Active directory Id for a user that you wish to add to this group.

Notice that the People picker shows few possible matches as you type. This is a functionality powered by new Search component in SharePoint 2013.

Once you enter the email you can add an Optional message for the users and send them an email notification by checking the box under “SHOW OPTIONS”.

![Add Users Pop-up](image)
Create new Permission Level

At some point, SharePoint 2013 site administrators would need to create a new Permission level or edit existing ones to customize the level of access that a user should have on the site. SharePoint 2013 by default includes seven default permission levels and 33 permissions which are used in these default permission levels. You can only customize the permissions contained within five of these permission levels as permissions within the Limited Access and Full Control are non-customizable.

Permissions broadly are categorized as list permissions, site permissions, and personal permissions, depending on the objects to which they can be applied. For example, site permissions apply to a particular site, list permissions apply only to lists and libraries and so on.

Adding a new Permission level is fairly easy in SharePoint 2013. You can use “Site Permissions” feature in Site Settings to edit or add a new Permission level.

To add a new Permission level in SharePoint 2013 follow the Steps below:

1. Click on Site Settings Wheel in the upper right corner of your site and select “Site Settings”.

2. In Site Settings Page, under “Users and Permissions” select “Site permissions”.

Demo SP2013 Team Site EDIT LINKS

Site Settings

Users and Permissions
People and groups
Site permissions
Site collection administrators
Site app permissions

Look and Feel
Design Manager
Master page
Title, description, and Page layouts and site
Welcome Page
3. Next, on User Permissions page select “Permission Levels” button in the Ribbon.

4. When the page with a list of all Permissions opens, select “Add a Permission Level” link towards top.
5. Next, in Add a Permission level Page enter Name and Description of the new permission level.

Select the desired List Permissions in new Permission level. In our case above, we selected “Add Items, Edit Items, View Items, Open Items and View Versions permissions so the Project coordinators can add\edit\view Items (or documents) but cannot delete it. Similarly, you can include other Site and Personal Permissions to assign it to your custom permission level. See the screen below.
Finally, click on Create to save your custom permission level.

Tip

Permission levels are defined at the site collection level and are inherited from the parent object by default.
Edit Permission level for default Members group

Unlike earlier versions of SharePoint, the default Members group in SharePoint 2013 has a new Permission level called “Edit”.

By definition, with Edit Permission level, users “Can add, edit and delete lists; can view, add, update and delete list items and documents.”

So if you add a new user in default Members group, with Edit Permission level, in addition to the Typical Contribute Permissions, users now have ability to “add, edit and delete lists” in your SharePoint 2013 Site.

The Screen below shows the difference between Contribute & Edit Permission levels.

It is important to change the Permission level for Default Members group to Contribute if you do not want your users to navigate to the List settings and delete it.

Please note that this is a governance decision. You may or may not want to change the Permission level for default Members group of your site.

If you want to edit the Permission level for default Member’s group follow the Steps below:

1. Click on Site Settings Wheel in the upper right corner of you site and select “Site Settings”.
2. In Site Settings Page, under “Users and Permissions” select “Site permissions”.

3. Next, on Site Permissions page select the default “Members group” for which you need to Change the Permissions and then select “Edit User Permissions” in the Ribbon.
4. In Edit Permissions page, uncheck “Edit” permission level and select “Contribute”.

5. Click Ok once done.

6. Finally, verify that the default Member’s group now has “Contribute” permission level assigned to it.
Set unique Permissions for a SharePoint 2013 List\Library

It’s a common requirement to break permission inheritance or set unique permissions for a List or Library in SharePoint.

If you want to edit the Permissions for a Document’s Library, follow the Steps below:

1. Click on Site Settings Wheel in the upper right corner of your site and select “Site Contents”.

2. In the Site Contents Page, select the document library you want to edit the permissions for.

3. In the Document Library Page, under “Library” tab in ribbon, select “Shared With”.

Copyright © 2013 LearningSharePoint.com. All Rights Reserved Worldwide.
4. In the Share popup, under “Shared With” on left, select ADVANCED.

5. On Permissions page, click on “Stop Inheriting Permissions”.

6. Click Ok on the following Change Permissions Popup.
7. The Library now has custom Permissions that you can edit by selecting a user and then “Edit User Permission” ribbon button.
Web Content Management

There are various Improvements in SharePoint 2013 to simplify Web Content Management.

From the famous Drag-and-Drop feature for uploading Multiple documents, to the support of Digital content Types (Audio, Video, Images); SharePoint 2013 has a lot to offer for Content Authors and end users.

In this Chapter we will look at some of these new Features and how to implement them in your SharePoint 2013 for facilitating end users and Content Authors.

IN THIS CHAPTER:

- Drag and Drop multiple documents.
- Move multiple documents from one library to another.
- Digital Assert Content Types.
- Asserts Library and new Video Content Type.
- IFrames in SharePoint 2013.
- How to add a YouTube Video in SharePoint 2013 site.
Drag and Drop Multiple documents

Microsoft has added a new Drag and Drop feature to highly popular document libraries in SharePoint 2013. On any document library, you can now Drag and Drop documents and SharePoint will upload them with a quick progress bar. Simply select multiple document from local and drag it onto the document library. The library List View will change to “Drop here” like below.

You can see the Upload documents Status bar next to the Document Libraries title.

The message turn to Upload Complete once the upload of documents Completes.

Tip
You cannot Drag and Drop Folders, Document Sets and Items in SharePoint 2013.
Move multiple documents from one library to another

With the introduction of Drag and Drop feature, a lot new functionalities have been added in SharePoint 2013. For example, in addition to dragging and dropping documents in a document library, you can also drag and drop them into a Folder in the same library or into another library that exist in your SharePoint site.

To move one or more documents from one library to another, you need to simply drag and drop the selected documents (from a source library) onto a destination Library listed in Quick launch Navigation of your SharePoint site.

For better understanding, let’s take two document libraries -
- Documents Library as Source Library and
- Archive Library as Destination Library

Now if want to move one or more documents from Source Library to Destination Library, you need to select the documents in Source Library first and then Drag and Drop them onto the Archive or Destination Library in the quick launch Navigation (on left) as shown in the Image below.

Notice the Icon in the document library turns to Move. Once you leave the documents onto the library they are added or moved to the targeted Library i.e. “Archive” in our case.
Digital Assert Content Types

In SharePoint 2013, Microsoft has introduced a new set of Content Types called “Digital Asset Content Types” that allows better use of Audio, Video and Images as Web Content in the site. These Digital Asset Content Types can be added to any library and can be used as a one of the items\files.

To view all Digital Asset Content Types available in your SharePoint 2013 site, Navigate to Site Settings -> Site Content Types and look for “Digital Asset Content Types”.

Once added, these Content types in a documents library, can be added from “New Document” button itself.
Asserts Library and new Video Content Type

In SharePoint 2013, Assert Library got a makeover to accommodate the newly added Digital Assert Content Types. In the new Asserts Library, there are various default Views like “ Thumbnails” and various new functionalities added like Capturing a Thumbnail while playing a Video etc.

To create an Assert Library, follow the Steps below:

1. Click on Site Settings Wheel in the upper right corner of your site and select “Site Contents”.

2. In the Site Contents Page, select Asserts Library and give it a name. We call it Video Library.

3. Once created, click on the new library.
Upload Videos to Asserts library

4. Once the Asserts Library is created, click on “new Item” to Upload Video in this library.

5. To Upload a Video, we download a sample Microsoft Video and uploaded it into this library.

5. Once the video is uploaded, you will be taken to Video item’s edit properties page.

Notice the option “Change thumbnail” in the Image library. This option is to upload a Video thumbnail either from Video itself or from your Computer system.
6. You can also choose Change Thumbnail to change thumbnail with the options as seen in the below screen.

   - Capture thumbnail from video
     Use camera button above after starting video playback to capture thumbnail from video
   - Use a picture from my computer
   - Use a picture from a web address

7. Let’s look at how to capture a Thumbnail from a video.

To capture a Thumbnail, Play the video and click on the “Capture Thumbnail” on the top of the video.
8. In addition to Thumbnail, there are other Properties for a Video that you can set.

9. Once you save the Video, it will be uploaded to Site Assets library and can be seen in Thumbnails view like below.
Iframes in SharePoint 2013

In SharePoint 2013, support for Iframes has been added as a part of Web Content Management (WCM) Enhancements.

With Iframes, admins can now embed dynamic content (such as videos or maps) from other sites on any SharePoint page by adding it into an HTML field (like the one of Content editor webpart or in a blog post Body field).

Any external domains that will be inserted in an Iframe should be added as Approved domains in “HTML Field Security” first. HTML Field Security is a new feature that you would find in Site Settings (of a Site collection) under “Site Collection Administration” section.

By default, certain trusted external domains are already approved for use in iframes. Site collection administrators however can customize the field security settings by changing the default trusted external domains and adding/removing the desired domains to be displayed in Iframes.

To configure a new Domain (for example Youtube.com in HTML Field Security), follow the Steps below:

1. Click on Site Settings Wheel in the upper right corner of you site and select “Site Settings”.

2. In the Site Settings page, under “Site Collection Administration” section select HTML Field Security.
3. Next in HTML Field Security, you can add the domain that you will use in an Iframe on your SharePoint site. In our case we added “Youtube.com” as a new permissive domain in our list.
How to add a YouTube Video in SharePoint 2013 site

Once we have our domain “Youtube.com” all setup in HTML Field Security, next we will look at the steps to embed a YouTube Video in SharePoint 2013 site page.

1. Navigate to your YouTube video and click on Share and then Embed.

Copy the highlighted text.

2. Next, in your SharePoint 2013 site, add a Content editor webpart on a page and then click on “Edit Source” in “Format Text” tab in Ribbon.
3. Add the following in the Source –

<iframe width="420" height="315"
src="http://www.youtube.com/embed/hyRLzUVw4Vw" frameborder="0"
allowfullscreen></iframe>

Once done, click ok. The Resulting Video should display in your SharePoint 2013 site’s page.